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1. INTRODUCCIÓN 

Este documento pretende guiar al usuario para la utilización de las bases de datos sobre 

proyecciones climáticas regionales marinas en España (PRME), desarrolladas en el marco 

del proyecto “Elaboración de la metodología y bases de datos para la proyección de 

impactos de cambio climático a lo largo de la costa española”, financiado por el Ministerio 

para la Transición Ecológica (MITECO). En este breve documento se describe tanto la 

organización de los datos generados de las proyecciones de cambio climático en la costa 

española, así como el formato y acceso a los mismos. 

Los datos que se ofrecen contienen información sobre cambios asociados al Cambio 

Climático ante diferentes escenarios futuros de calentamiento y desarrollo socio-económico 

para las variables ambientales: oleaje, nivel del mar y temperatura superficial marina. Más 

información sobre la base de datos desarrollada se presenta en la sección 2 de este 

documento. 

El acceso a los datos generados se ofrece de dos formas distintas: 

1) A través de un visor online, que ofrece la información sintetizada y simplificada. 

Más detalles sobre el contenido y funcionamiento del mismo se presentan en la 

sección 4.1 de este documento. 

2) Mediante descarga online de las bases de datos. Más detalles sobre cómo utilizar el 

servicio de descarga se presenta en la sección 4.2 de este documento. 

 

2.  ORGANIZACIÓN Y DESCRIPCIÓN DE LOS DATOS 

Los datos que se entregan se organizan en una serie de ficheros que contienen el valor de 

cambio estimado para escenarios futuros. En concreto, se proporcionan los valores medios 

estimados de cambio (mean ensemble multi-modelo) así como su incertidumbre asociada 

para cada una de las variables marinas analizadas, tanto para un corto-medio plazo (2026-

2045) como a largo plazo del S.XXI (2081-2100), y para dos escenarios climáticos futuros 

considerados (denominados RCP4.5 y RCP8.5). La incertidumbre asociada se ha 

caracterizado mediante la desviación típica y los límites (5%, 95%) de los intervalos de 

confianza al 90%.  

La información que se ofrece se clasifica en dos carpetas, en función del dominio espacial 

que abarcan los ficheros:  

 Costa: estos ficheros contienen puntos discretos a lo largo de la costa española. 

En total son 1196 puntos, de los cuales 601 corresponden al dominio atlántico 

(Cantábrico, Golfo de Cádiz y Canarias) y 595, al dominio mediterráneo (costa 

mediterránea, Baleares y Ceuta y Melilla). 

 Océano: son mapas que abarcan la región oceánica (atlántica y mediterránea) de 

España. Consisten en una malla rectangular que abarca la extensión comprendida 

entre 20ºO y 9ºE de longitud y desde 25º hasta 46.75ºN de latitud. 
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A su vez, dentro de cada una de estas carpetas, los datos se organizan en una serie de 

subcarpetas en función de:  

1) el escenario climático analizado: rcp4.5 o rcp8.5,  

2) el periodo futuro para el que se proporcionan los cambios estimados: corto-medio plazo 

(2026_2045) o largo plazo (2081_2100),  

3) la dinámica marina considerada. Estas dinámicas son: 

- Oleaje y marea meteorológica (se entregan en el mismo fichero), 

- nivel del mar, 

- temperatura superficial del agua de mar.  

 

La figura 1 muestra la organización de las carpetas en el orden mencionado:  

 

Figura 1. Organización de las carpetas siguiendo el orden explicado anteriormente. 

 

Además, para el dominio “Costa” también están disponibles los datos de profundidad para 

cada uno de los puntos costeros proporcionados y los resultados de la variable de Nivel del 

mar compuesto. La profundidad representa un valor medio para áreas de 

aproximadamente 50 km2. La variable de Nivel del mar compuesto incluye las componentes 

nivel medio del mar, marea astronómica y meteorológica combinadas.  



 
 

GUÍA PARA EL ACCESO A LAS BASES DE DATOS DE PRME 

 

- 5 - 

 

 

A modo de resumen, la tabla 1 muestra las variables y estadísticos disponibles para cada 

una de las dinámicas analizadas. En los apartados 2.1-2.4 se describen con más detalle 

estos datos para cada una de las dinámicas por separado. 

Tabla 1. Resumen de los estadísticos disponibles para cada una de las variables analizadas. 

 

2.1. Oleaje y marea meteorológica 

Los resultados de las proyecciones dinámicas de oleaje y marea meteorológica para los 

dos dominios espaciales especificados (costa y océano), y para cada escenario climático y 

periodo futuro analizado, se estructuran de la siguiente manera: 

 Dominio costa: Los puntos de cada dominio (atlántico y mediterráneo) se entregan 

en ficheros separados, ya que la resolución de las mallas es distinta (0.1º para el 

dominio atlántico y 0.08º para el mediterráneo). Así, los ficheros del dominio 

atlántico tienen el prefijo "ATN", mientras que los del mediterráneo, "MED". En estos 

puntos están disponibles los datos correspondientes a los cambios en las 

climatologías medias entre el periodo futuro (ya sea a corto-medio o largo plazo) y 

el clima presente o periodo de referencia (1985-2005). En concreto, los ficheros 

contienen el valor medio y percentil del 99.9% a partir de todos los modelos 

utilizados (junto con su incertidumbre asociada) de los cambios 20-anuales y 

mensuales en de cada una de las variables (altura de ola significante, periodo 

medio, periodo de pico, dirección media del oleaje y marea meteorológica).  

 

 Dominio océano: La resolución de estos mapas es de 0.5º en el dominio atlántico 

y de 0.25º en el mediterráneo. Nótese que esta resolución es más grosera que la 

de los puntos contenidos en la carpeta “Costa” por lo que, para aquellos usuarios 

interesados en puntos costeros, se recomienda utilizar los ficheros contenidos en 

“Costa”. Cada nodo de la malla contiene los cambios 20-anuales en las distintas 

Dinámica marina Variable
Estadísticos en dominio 

“Costa”

Estadísticos en dominio 

“Océano”

Altura de ola 

significante  (Hs)

Valor medio, percentil del 

99.9%
Valor medio y percentil del 99%

Periodo medio  (Tm)
Valor medio, percentil del 

99.9%
Valor medio  y percentil del 99%

Periodo de pico  (Tp)
Valor medio, percentil del 

99.9%
Valor medio y percentil del 99%

Dirección media del 

oleaje  (Dir)
Valor medio Valor medio

Nivel medio del mar 

(NMM)
Valor medio Valor medio

Marea 

meteorológica  (MM)
Percentil del 99.9%  Percentil del 99%

Nivel del mar 

compuesto  (NMC)

Valor medio y percentil del 

99.9%
-

Temperatura superficial del mar

Temperatura 

superficial del mar 

(SST)

Valor medio Valor medio

Oleaje

Nivel del mar
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variables entre el periodo futuro (ya sea a corto-medio o largo plazo) y el periodo 

de referencia (1985-2005). Estos cambios se ofrecen para el valor medio obtenido 

a partir de todos los modelos (junto con su incertidumbre asociada). Los 

estadísticos analizados son el valor medio y el percentil del 99%.  

2.2. Nivel medio del mar 

A continuación, se describe el contenido de los ficheros de cambio en el nivel medio del 

mar (NMM) en las dos carpetas de "costa" y "océano" (que, a su vez, se dividen en cada 

una de las subcarpetas correspondientes al escenario climático y periodo futuro): 

 Dominio costa: en los 1196 puntos distribuidos a lo largo de la costa española, se 

han calculado los cambios 20-anuales en el nivel medio del mar (2026-2045 y 2081-

2100) respecto al valor estimado a partir del periodo 1986-2005 (representativo 

del clima presente).  

 

 Dominio océano: contiene los cambios 20-anuales (2026-2045 y 2081-2100) en el 

nivel medio del mar, respecto al valor medio durante el periodo 1986-2005. La 

resolución de esta malla es de 1º.  

 

2.3. Temperatura superficial del agua de mar 

Las proyecciones climáticas de la temperatura superficial del agua de mar (Sea Surface 

Temperature, SST) para los escenarios climáticos rcp4.5 y rcp8.5 y para los periodos de 

corto-medio y largo plazo se entregan para ambos dominios, "costa" y "océano": 

 Dominio costa: en los 1196 puntos distribuidos a lo largo de la costa española, se 

han calculado los cambios 20-anuales medios en la temperatura superficial del mar 

en los periodos 2026-2045 y 2081-2100, respecto al valor medio en el periodo 

1986-2005 (representativo del clima presente).  

 

 Dominio océano: se entrega el mean ensemble (e incertidumbre asociada) de los 

cambios 20-anuales medios en los periodos 2026-2045 y 2081-2100 respecto al 

valor medio en el periodo 1986-2005, para 4 regiones analizadas (Cantábrico, 

Canarias, Mediterráneo y Estrecho).  

 

2.4. Nivel del mar Compuesto 

A partir de las proyecciones climáticas del nivel medio del mar y marea meteorológica, se 

ha calculado el nivel del mar total en ausencia de oleaje (es decir, sin tener en cuenta el 

run-up) pero teniendo en cuenta el efecto de la marea astronómica. Para ello, se ha 

reconstruido la serie temporal a lo largo del siglo XXI de la marea (asociada a las fuerzas 

gravitacionales del Sol y la Luna). La variable de nivel del mar compuesto (nombrada Still 

Water Level, SWL, en inglés) se ha calculado como la suma de la marea astronómica, la 

marea meteorológica y las variaciones del nivel medio del mar. Esta variable se calcula 

para los 1196 puntos costeros, por lo que sólo está disponible en la carpeta “Costa”.  
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 Dominio costa: Los ficheros que se entregan corresponden con los cambios a corto-

medio y largo plazo (2026-2045 y 2081-2100) del nivel del mar compuesto, para 

los dos escenarios climáticos analizados.  Estos cambios se han calculado tanto para 

el valor medio como para el percentil del 99.9%.  

 

3. TIPO DE FORMATO DE LOS ARCHIVOS (NETCDF) 

Todos los archivos generados tienen formato NetCDF (network Common Data Form), ya 

que es un formato ampliamente utilizado por la comunidad climática y meteorológica a 

nivel mundial. Estos archivos permiten almacenar datos en forma matricial y tienen la 

ventaja de que son autodescriptivos, portables, escalables, agregables, etc. En los archivos 

generados, la descripción de los metadatos sigue las recomendaciones establecidas por 

Climate and Forecast (CF) Metadata Convention (http://cfconventions.org/).  

La figura 2 muestra un ejemplo de parte del contenido de un fichero NetCDF. En concreto, 

corresponde a los cambios en la temperatura superficial del agua de mar para el escenario 

rcp4.5, en el periodo 2026-2045, en la región del Mediterráneo. La segunda línea específica 

las dimensiones del fichero (en este caso, longitud (143 valores) y latitud (132 valores)). 

A continuación, se describen algunas de las variables contenidas en el fichero, como son 

la longitud, la latitud y el mean ensemble del cambio medio en la temperatura superficial 

del mar (delta_sst_mean). La información que se proporciona de cada una de estas 

variables está en forma de atributos, como por ejemplo las unidades o la definición de la 

variable (tanto en castellano como en inglés). Por último, se especifican una serie de 

atributos globales que aporta información relevante sobre cómo se han generado los datos. 

http://cfconventions.org/
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Figura 2. Pantallazo de parte del contenido de un fichero NetCDF donde se muestran los atributos que definen 

cada una de las variables. 

 

Para el análisis y lectura de los datos de NetCDF, se pueden utilizar distintos lenguajes de 

programación como Matlab, Python, R, etc. Cada uno de ellos tiene una serie de librerías 

y paquetes específicos para trabajar con este tipo de ficheros. Además, para conocer la 

información contenida en estos ficheros, mediante extracción de valores de interés o 

visualización de datos espaciales o series temporales, existen diversas aplicaciones y 

herramientas de libre acceso. Una herramienta de amplio uso, es el software libre Panoply, 

desarrollado por el organismo NASA. Panoply funciona en distintos sistemas operativos y 

se puede descargar y obtener información a través de: www.giss.nasa.gov/tools/panoply. 

Con esta herramienta se pueden cargar ficheros NetCDF previamente descargados al disco 

local (File > Open, o arrastrando directamente el fichero) o situados en un repositorio 

remoto a través de la dirección url (File > Open Remote Dataset). La figura 3 muestra la 

ventana que se visualiza con el software Panoply una vez cargado un fichero.  

http://www.giss.nasa.gov/tools/panoply
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Figura 3. Ventana del Panoply una vez cargado el fichero cambios_SST_Mediterraneo_rcp45_2026_2045.nc. La 

parte izquierda de la pantalla muestra la lista con el nombre y definición de las distintas variables y la de la 

derecha, los atributos de una variable seleccionada. 

 

En el panel de la izquierda aparecen las distintas variables contenidas en el fichero y su 

definición. Si se selecciona alguna de ellas, el panel de la derecha muestra los atributos 

específicos de esa variable. Además, haciendo doble clic sobre la variable se abre otra 

ventana que permite visualizar el mapa con los valores de dicha variable (opción “Create 

a georeferenced Longitude-Latitude plot”). Se puede hacer zoom arrastrando con el ratón 

y a la vez pulsando la tecla Control (figura 4). Por último, se pueden exportar el contenido 

de una variable en formato csv (formato de tabla). Para ello, seleccionar la variable > File 

> Export Data > As CSV. Se guarda el contenido de la matriz sin información sobre su 

localización. Los valores ‘NaN’ (Not a Number’) que aparecen en la base de datos 

proporcionada corresponden con valores en tierra o fuera del dominio analizado. 

 

Figura 4. Visualización de los valores de la variable delta_sst_mean, correspondiente al valor medio de los 

cambios en la SST para el escenario rcp4.5 y el periodo 2081-2100, en la región del Mediterráneo. 



 
 

GUÍA PARA EL ACCESO A LAS BASES DE DATOS DE PRME 

 

- 10 - 

 

4. ACCESO TELEMÁTICO A LAS BASES DE DATOS 

Los datos procesados de las proyecciones climáticas regionales marinas están disponibles 

a través de dos sistemas de acceso. Por un lado, la información sintetizada y simplificada 

se puede consultar y descargar a través del visor online C3E, http://c3e.ihcantabria.com, 

desarrollado a partir de la tecnología de Google Earth. Por otro lado, la base de datos con 

los resultados sobre las proyecciones regionales con información completa se encuentra 

alojada en un repositorio al que se puede acceder a través de un servidor Thredds. 

4.1 Visor C3E 

El visor online C3E permite visualizar y descargar en formato .kmz, los resultados más 

relevantes de las proyecciones climáticas. Debido al gran volumen de información, se ha 

seleccionado aquélla que se considera más útil para la mayoría de los usuarios. Dicho visor 

consta de una serie de capas generadas a partir de los datos descritos anteriormente. En 

concreto, están disponibles los siguientes datos: 

- Cambios en el valor medio y percentiles de la altura de ola significante (Hs), periodo 

de pico (Tp) y dirección media del oleaje (Dir) para los dos escenarios climáticos y 

para ambos periodos futuros, así como para el periodo de referencia 1985-2005, 

representativo del clima actual. 

- Cambios en el percentil del 99% (o 99.9% en costa) de la marea meteorológica 

(MM) para los dos escenarios climáticos y para ambos periodos futuros, así como 

para el periodo de referencia 1985-2005, representativo del clima actual. 

- Cambios en el valor medio de la temperatura superficial (SST) y nivel medio del 

mar (MSL) para los dos escenarios climáticos y para ambos periodos futuros. 

Además, se proporciona el límite superior del intervalo de confianza del 90% para 

la variable MSL. Los valores medios de SST característicos del clima actual también 

están disponibles. 

- En costa, se proporcionan los cambios en el valor medio y percentiles del nivel del 

mar compuesto (NMC) para los dos escenarios climáticos y para ambos periodos 

futuros. 

En el visor, a los dominios “costa” y “océano” se les llama dinámica costera (“D. Costera”) 

y dinámica marina (“D. Marina”), respectivamente. 

La figura 5 muestra la pantalla del visor con las distintas opciones disponibles. En el panel 

izquierdo aparecen las distintas variables, periodos y escenarios disponibles para ser 

seleccionados. El panel superior muestra las opciones de dinámica marina o costera. Para 

visualizar o descargar la capa, se debe de seleccionar con el ratón la opción que interese 

y pulsar en “Ver Capa” o “Descargar”.  

http://c3e.ihcantabria.com/
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Figura 5. Ejemplo del menú y aspecto del visor para el caso de las dinámicas Marinas. 

 

Las capas de dinámica costera muestran los resultados en el área comprendida entre 20ºO 

y 9ºE de longitud y de 25º a 46.75ºN de latitud. Los puntos indican concordancia en el 

signo del cambio en, al menos, el 80% de los modelos climáticos utilizados. 

La figura 6 muestra un ejemplo de la capa correspondiente al cambio a largo plazo (2081-

2100) en el percentil del 99% del periodo de pico asociado al oleaje para el escenario 

rcp8.5. Por último, la figura 7 muestra un ejemplo de la capa correspondiente a dinámica 

costera del cambio en el percentil del 99.9% del periodo de pico para el periodo 2026-

2045 y para el escenario rcp8.5. Al pinchar en cualquiera de los puntos, aparece una 

ventana con información sobre la localización de ese punto, así como el valor medio del 

cambio y sus intervalos de confianza del 90%. 
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Figura 6. Ejemplo de la capa correspondiente a la dinámica marina del cambio a largo plazo (2081-2100) en el 

percentil del 99% del periodo de pico asociado al oleaje para el escenario rcp8.5. 

 

 

Figura 7. Ejemplo de la capa correspondiente a la dinámica costera del cambio en el percentil del 99.9% del 

periodo de pico. Al pinchar en un punto aparece información sobre la localización, valor medio del cambio y límites 

(del 5% y 95%) del intervalo de confianza del 90%. 
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4.2 Acceso a la base de datos a través del servidor Thredds online 

Los datos generados son de libre acceso y descarga a través del servidor de datos 

THREDDS (TDS, Thematic Realtime Environmental Distributed Data Service). El enlace al 

servidor Thredds creado en el marco de este proyecto es el siguiente: 

http://thredds.ihcantabria.com/PRME/catalog.html 

Este enlace da acceso a la carpeta de PRME (figura 8), cuyo contenido se ha explicado en 

el apartado 2. 

 

Figura 8. Pantalla que muestra el explorador al acceder al servidor Thredds: 
http://thredds.ihcantabria.com/PRME/catalog.html 

El servidor Thredds está implementado en Java y permite la conectividad entre el servidor 

de datos y el usuario. A través de este servidor se generan catálogos XML que proporcionan 

directorios virtuales sobre los datos disponibles y sus metadatos asociados.  

La descarga de los datos se puede realizar mediante distintas herramientas o aplicaciones. 

Se pueden descargar en su formato original (netCDF, con las opciones de HTTPServer y 

NetcdfSubset), en formato ASCII o binario (con la opción OPeNDAP). A modo de ejemplo, 

la imagen inferior muestra la pantalla que se visualiza en el explorador cuando se 

selecciona un fichero específico (en este caso los datos de aumento del nivel medio del 

mar a fin de siglo para el escenario rcp8.5) (figura 9). Tal y como se observa en la imagen, 

este servidor da información básica sobre el fichero (nombre, tamaño, tipo de datos y fecha 

de creación), enumera las distintas opciones de acceso y descarga del fichero, así como 

las diferentes herramientas disponibles para visualizar el contenido de dicho fichero. 

http://thredds.ihcantabria.com/PRME/catalog.html
http://thredds.ihcantabria.com/PRME/catalog.html
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Figura 9. Pantalla que muestra el explorador al seleccionar un fichero específico dentro de la plataforma Thredds. 

Aparece información básica sobre el fichero (1), se muestran las distintas opciones de acceso y descarga del 

fichero (2), y diferentes formas de visualizar el contenido de dicho fichero (3). 

Entre las opciones de visualización de los ficheros (3), están disponibles las siguientes:  

a) Godiva2: esta aplicación Web permite la visualización directa de los datos sin 

previa descarga. Se debe seleccionar la variable que se desea visualizar entre 

todas las variables disponibles en un fichero. El panel de la derecha muestra el 

mapa con los valores de la variable seleccionada y la escala de colores, cuyos 

límites pueden ser fijados por el usuario. Se recomienda pulsar la opción “auto” 

para que la escala de colores se ajuste automáticamente al rango de valores. A 

modo de ejemplo, la figura 10 muestra los cambios (en metros) en el valor 

medio de la altura de ola significante en el periodo 2081-2100, para el escenario 

rcp8.5, respecto al periodo de referencia 1985-2005.  

 

b) NetCDF-java ToolsUI y Integrated Data Viewer (IDV): estos servicios permiten 

descargar el fichero en formato JNLP para, posteriormente, ser visualizado en 

aplicaciones como ToolsUI o IDV, que funcionan con el software de Java Web 

Start. 
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Figura 10. Pantalla que muestra el explorador al seleccionar la opción de visualización Godiva2. En la parte 

izquierda, aparecen las distintas variables contenidas en el fichero que se pueden seleccionar para ser 

visualizadas. El panel de la derecha muestra el mapa con los valores de la variable seleccionada, así como la 

escala de colores, cuyos límites se pueden ajustar pulsando la tecla “auto”.  

A continuación, se describen brevemente las distintas opciones de acceso y descarga a los 

datos (2): 

1. OPENDAP: El servicio OPENDAP está muy extendido entre las herramientas 

científicas y permite acceder a los datos del fichero a través de la dirección url sin 

necesidad de descargarlos en el disco local. Esa dirección url se puede copiar y 

pegar en Panoply (tal y como se comentó anteriormente) para visualizar el fichero 

con dicha aplicación. Al igual que el WMS y WCS, OPeNDAP está diseñado para ser 

integrado en otra aplicación, tales como Matlab, Octave, Python, R, etc., que 

también utilizan la dirección url como ruta de acceso remoto a los datos. En el caso 

de que se desee descargar el contenido del fichero al disco local a través de 

OPeNDAP, este servicio permite seleccionar las variables de interés y filtrar las 

matrices por sus índices. La descarga puede ser en formato ASCII (Get ASCII) o 

binario (Get Binary) (figura 11).  
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Figura 11. Pantalla que se muestra al elegir la opción de acceso por OPeNDAP. En este caso se ha seleccionado 

la variable delta_dir_mean y dentro de ella, todos los valores de latitud ([0:1:44]) y longitud ([0:1:38]). Pulsando 

la tecla “Get ASCII” se descargan esos datos seleccionados en formato de texto. 

 

2. HTTP Server: este es el servicio más simple y permite la descarga directa de todo 

el archivo. 

3. WMS y WCS: Al igual que el OPENDAP, estos servicios están diseñados para ser 

integrados en otras aplicaciones que, en este caso suelen ser visores GIS o 

herramientas de gestión GIS. Con los servicios Web Mapping Service (WMS) y Web 

Coverage Service (WCS), los datos se descargan en forma de mapas (imágenes) 

georeferenciados. 

4. NetcdfSubset: Su uso es similar a la de HTTPServer, con la diferencia de que 

permite la selección para descarga de la/s variable/s de interés, así como delimitar 

el fichero de descarga a una región más pequeña mediante selección de los límites 
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norte-sur y oeste-este. Para ello, se recomienda hacer zoom sobre la zona de 

interés y moviéndonos con el ratón conocer las coordenadas de los extremos de 

dicha zona. Por último, esas coordenadas se escriben en los recuadros de norte, 

sur, este y oeste para fijar la descarga a esa área. La figura 12 muestra las opciones 

que ofrece esta aplicación. 

 

Figura 12. Pantalla que muestra el explorador al seleccionar la opción de acceso/descarga NetcdfSubset. Aparecen 

las distintas variables contenidas en el fichero que se pueden seleccionar para ser descargadas. El panel de la 

derecha muestra un recuadro con el dominio espacial del fichero y la opción de seleccionar un subconjunto más 

pequeño, fijando los límites espaciales. 

 

4.2.1. Datos adicionales 

Los datos descritos en el apartado 2 son los resultados post-procesados generados a partir 

de las proyecciones de cambio climático realizadas. Estos datos son los que suele requerir 

el usuario general y, tal y como se menciona anteriormente en este documento, son de 

acceso libre y descarga gratuita. Para usuarios más avanzados se dispone de otra serie de 

ficheros, cuyo acceso requiere el uso de un usuario y contraseña. Para acceder a estos 

datos, el usuario debe de ponerse en contacto por email con los gestores de estos datos a 

través del correo ihdata@ihcantabria.com, especificando la información/datos que se 

solicitan. Estos datos están disponibles en el siguiente enlace de la plataforma Thredds: 

http://thredds.ihcantabria.com/PRME_2/catalog.html 

En este repositorio se encuentra información extendida de las proyecciones realizadas para 

los dos dominios espaciales nombrados anteriormente (océano y costa), para cada uno de 

los dos escenarios climáticos considerados (rcp4.5 y rcp8.5) y en los dos periodos futuros 

analizados (2026-2045 y 2081-2100). En concreto, están disponibles las series temporales 

mailto:ihdata@ihcantabria.com
http://thredds.ihcantabria.com/PRME_2/catalog.html
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(horarias, mensuales o anuales, dependiendo de la variable) de las distintas variables 

analizadas para cada uno de los miembros del ensamble. También se proporcionan los 

cambios en los estadísticos de las distintas variables a corto-medio y largo plazo obtenidos 

para cada uno de los modelos climáticos empleados. El número de modelos climáticos 

disponibles para cada variable puede variar. Además, para el caso de la región 

mediterránea se han utilizado modelos climáticos a escala regional. 

A continuación, se describe la información disponible para cada una de las variables 

analizadas que, a su vez, se resumen en la tabla 2: 

- Oleaje y marea meteorológica: en la carpeta “costa” se encuentran las series 

temporales horarias para cada uno de los escenarios y modelos climáticos 

analizados. Está disponible tanto el periodo histórico o de referencia (1985-2005), 

como el corto-medio (2026-2045) y largo (2081-2100) plazo. Además, se 

proporcionan los cambios anuales en el valor medio y percentiles 

[1:1:99,99.5,99.9%] de cada uno de los modelos, escenarios y periodos de tiempo 

analizados. En la carpeta océano, están disponibles los cambios 20-anuales para 

cada uno de los miembros individualmente en el dominio oceánico. 

- Nivel medio del mar: se encuentran las series temporales anuales del mean 

ensemble multimodelo e incertidumbre asociada en los puntos costeros (carpeta 

“costa”). 

- Nivel del mar compuesto: están disponibles las series temporales horarias para 

cada uno de los modelos climáticos considerados en las proyecciones de marea 

meteorológica, así como para cada uno de los escenarios de cambio climático y 

periodos de tiempo considerados. Además, también se proporcionan los cambios 

para cada uno de los miembros (modelos climáticos) y escenarios por separado. Al 

igual que para el nivel medio del mar, estos datos sólo están disponibles para el 

dominio “costa”. 

- Temperatura superficial del agua de mar: en el dominio “océano” están disponibles 

las series temporales mensuales para el periodo continuo 2006-2100 (y 1986-2005 

en el caso del periodo histórico o de control) de cada uno de los escenarios y 

modelos climáticos considerados. 

 

Dinámica 
marina 

Variable Datos en dominio “Costa” 
Datos en dominio 

“Océano” 

Oleaje 

Altura de ola 
significante (Hs) 

Series 

temporales 
horarias de 

cada modelo 
climático 

Cambios anuales en 
valor medio y 

percentiles para 
cada modelo 

climático 

Cambios 20-anuales 
en valor medio y 
percentil del 99% 
para cada modelo 

climático 

Periodo medio (Tm) 

Periodo de pico (Tp) 

Dirección media del 
oleaje (Dir) 

Cambios anuales en 
valor para cada 
modelo climático 

Cambios 20-anuales 
en valor medio para 

cada modelo 
climático 

Nivel del mar 

Nivel medio del mar 
(NMM) 

Serie temporal 
anual del 

mean 
ensemble 

- - 

Marea meteorológica 
(MM) 

Series 
temporales 

Cambios anuales en 
percentiles para 

Cambios 20-anuales 
en el percentil del 
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horarias de 
cada modelo 

climático 

cada modelo 
climático 

99% para cada 
modelo climático 

Nivel del mar 
compuesto (NMC) 

Cambios anuales en 
valor medio y 

percentil del 99.9% 
para cada modelo 

climático 

- 

Temperatura 
superficial del 

mar 

Temperatura superficial 
del mar (SST) 

- - 
Series temporales 

mensuales para cada 
modelo climático 

Tabla 2. Resumen de los datos disponibles en la carpeta PRME_2 para cada una de las variables analizadas. 

 

Para información más detallada de los datos, así como de su proceso de generación, se 

recomienda consultar el informe técnico disponible en el mismo sitio de descarga de este 

documento. 

   


